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Building Better Schedules with Microsoft Project 2010 (PRO)
In this 45 minute web-session, weôll show you the five essential building blocks for developing a fool-

proof schedule. You will also learn how the new features in Microsoft Project 2010 Professional can help 

you build more reliable schedules, faster and easier than ever before!

ÅUnderstanding the Task Planning 

Process

ÅCreating the Work Breakdown 

Structures

ÅUsing Task Dependencies

ÅSetting Task Constraints and 

Deadlines

ÅUsing the Task Inspector to 

Determine Task Drivers

Thursday April 21st at 1:30pm EDT

Participants will qualify for 1 PDU



Building Better Schedules with 

Microsoft Project Professional 2010

Call: (888) 320-3585

or +1 (425) 706-3500

Participant code: 78358195

www.sharkprosoftware.com
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Questions and Answers

ÁSubmit text questions using the 

ñAskò button 

OR

ÁContact us at: 

lhanley@sharkprosoftware.com
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AGENDA

ÁUnderstanding the Task 

Planning Process

ÁCreating the Work Breakdown 

Structures

ÁUsing Task Dependencies

ÁSetting Task Constraints and 

Deadlines

ÁUsing the Task Inspector to 

Determine Task Drivers

ÁQ&A
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SharkPro Software

Focused on lowering the time, cost and 

risk of project & portfolio management

ÁEnterprise Project Management (EPM) 

Solutions
ï Design & Deploy effective and practical solutions 

tailored to specific business needs

ï Technical support, enhancements, integrations

ÁUpgrades to Project Server 2010

ÁProject Management Training
ï Courses for PMs, Team Members, Administrators

ï Custom User Training

ÁSharkPro Projects ready-to-go PPM
ï For the new PMO, department, or mid-sized 

business
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SharkPro Projects

SharkPro Projects is a preconfigured

implementation of Project Server 2010

ÁDeployed in hours hosted or on site

ïLowers the time, cost and risk of 

implementing Microsoft Project Server 

ÁEasy to use, wide-spread adoption 

ïEnables collaboration by team members 

and others not familiar with Project Server

ïEarly success leads to quicker adoption

ïCompanies immediately successful and 

grow with Microsoft Project Server

Reports

Task Timer
Workflow

Timesheets

Requests Risks

Timeline

Status

Alerts

Collaboration



Understanding the 

Task Planning Process
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Entering and Editing Tasks

ÁReview 

ïAuto-Wrapping tasks

ïSummary tasks (deliverables)

ïMilestones

Á 1
6
1
+



www.sharkprosoftware.comCopyright 2011  SharkPro Software9

Auto -Wrapping Task Names

ÁNow in 2010, auto-wrapping of task names will 

occur when one of the following events occur:

1. You manually type a name that exceeds the width of 

the Task Name column

2. You paste a name that exceeds the width of the 

Task Name column

3. You manually decrease the width of the Task Name 

column, causing the text to rewrap

4. You manually increase the width of the Task Name 

column, causing the text to rewrap
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Inserting Summary Tasks

Inserting Summary Tasks in now made easier from 

the Format tab in the Ribbon.
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Inserting a Milestone Task

Inserting Milestone Tasks is now made easier from 

the Format tab in the Ribbon.
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Manual vs Auto Scheduled 

Tasks

ÁManually Scheduled Tasks

ïUser specifies dates, the tool does not 

calculate them

ïDate fields are text fields

ÁAuto Scheduled Tasks 

ïTasks scheduling MS Project has always 

used

ïDates are automatically calculated when 

duration is entered
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Scenarios for Manual vs 

Automatic Tasks

ÁYou are given a time frame to deliver a 

project

ÁYou begin with a high level task list

ÁThere are areas within your project which 

are currently in the beginning stages or 

donôt have a well understood or defined 

scope
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Manual vs Automatic 

Scheduled Tasks 

Å Easy to switch between Manually Scheduled and Automatically 

Scheduled mode for one or more selected tasks.  When 

entering new tasks, the status bar shows the default task mode 

in use.
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Manual vs Automatic 

Scheduled Tasks 

Company
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Manual vs Automatic 

Scheduled Tasks 

ÁUser-controlled scheduling

Å Project will by default create tasks in Manually 

Scheduled task mode when lists are copied 

from another application. 

Å Brings together the flexibility and ease of a tool 

like Excel 2010 with the power of the Project 

2010 scheduling engine. 
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Creating the 

Work Breakdown Structures
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Entering and Editing Tasks

ÁReview 

ïCreate WBS with Manual Tasks

ÅTop-Down Planning

ÅComparison to Estimates

ïLinking Tasks

ïTask Dependencies

ïDeadlines

Á 1
6
1
+
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Scheduled Start, Finish, & 

Duration Fields

ÁThese fields capture, in Read Only format, Start, Finish, 

and Duration that was originally planned 

ÁAs actual Start, Finish, and Duration changes for each 

task within the natural course of a project, these fields 

will hold the original dates as a constant within your plan.
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Linking Tasks

To link tasks in the 

Gantt Chart view:

ÅOn the View tab, 

in the Task Views 

group, click Gantt 

Chart

Å In the Task Name 

field, select two 

or more tasks to 

link, in the order 

needed
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Linking Tasks

ÅTo select tasks that are next to one another, hold down 

SHIFT and click the first and last task that you want to link.

ÅTo select tasks that are not next to one another, hold down 

CTRL and click the tasks that you want to link.

On the Task tab, in the Schedule group, click the Link Tasks 

button.
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Using Task Dependencies
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Using Task Dependencies

ÁFinish to Start

ÁStart to Finish

ÁStart to Start

ÁFinish to Finish

ÁLag and Lead time

Microsoft Project 2010 defaults to the finish to start 

dependency
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Using Task Dependencies

ÁLag Time

ÁLead Time

A

B

FS +4days

A

B

FS ï2days
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Using Task Dependencies

Start to Start 

A

B

C

SS
B
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Task Dependencies 

and Finish Dates

ÅMake sure every detail task and milestone 

has a dependency tied to its finish date.
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Dependencies 

and Summary Tasks

ÅDo not put dependencies on summary 

tasks
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Changing Task Dependencies

1. Double Click on the 

Task

2. Click on the 

Predecessors Tab

3. Click on the Drop Down 

to change the Type
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Setting Task Constraints 

& Deadlines
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Deadlines vs. Start/Finish Date 

Constraints

Á If you want a task to start or finish on a certain date but 

want to retain the flexibility of the schedule, you can 

enter a deadline date. 

1. Double-click on a task

2. on the Advanced tab, enter a date in the Deadline box. 

3. A green arrow will appear on your Gantt chart that marks the 

deadline date. 

4. If the task doesn't finish by the deadline date, a nasty icon will 

appear in the Indicators column to warn you. 

http://blogs.msdn.com/blogfiles/project/WindowsLiveWriter/TipsandTricksCreateDeadlineDates_132AB/clip_image002_2.jpg


www.sharkprosoftware.comCopyright 2011  SharkPro Software34

ÁYou can also enter a task deadline in the Task 

Information dialog box. Click Task Information and 

then click the Advanced tab. Click the date in the 

Deadline box.

Setting Task Deadlines
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Setting Task Deadlines

ÁDeadlines

ïAdd the Deadline field to the Entry table of the Gantt 

Chart view, and set the deadline dates for these tasks
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Setting Task Constraints 

and Deadlines

ÁConstraint ïa restriction that you set on the start 

or finish date of a task limiting the softwareôs 

ability to automatically reschedule the taskôs 

start or finish date based on schedule changes

ÁDeadline ïsimilar to constraints but do not limit 

the scheduling engine
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Scenarios for Active vs 

Inactive tasks

ÁManaging scope, ie taking tasks out of a project

ÁProviding alternative options within a project

ÁProviding risk mitigation tasks that can easily be 

enabled if necessary
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Active vs Inactive tasks

ÁInactive Tasks do not affect the schedule
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Inactivating Tasks

ÁHighlight all 

tasks that need to

be inactivated

ÁClick on Inactive

icon
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Inactivating Tasks

Comp.

Co.
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Inactivating Tasks

Co.
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Inactivating Tasks
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Active Field

ÁCan be used to: 
ï Identify Inactive tasks

ïActivate or Deactivate many tasks simultaneously
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Summary

ÁManual scheduling is going to be really useful for...

ïPMs who use Excel

ïTop down planning

ïRolling-wave planning

ïShowing and modelling ambiguous tasks

ïProviding complete control

ÁInactive tasks are really useful for 

ïScope management

ïDefining alternative scenarios and what-if

ïAllows inclusion of risk mitigation actions
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Using the Task Inspector to 

Determine Task Drivers
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User-Controlled Scheduling

ÁUser-Controlled Scheduling breaks the 

traditional ñCritical Path Methodò scheduling 

methodology in order to make it easier for users 

to model their work and activities

ÁñManually Scheduled Tasksò allow listing tasks 

with no dates, no durations, and no 

dependencies

ÁEven summary tasks can be manually 

scheduled and have a duration different than the 

elapsed time of their subtasks
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Task Inspector Tool

The Task Inspector Tool provides 

ÅContext-driven guidance for analyzing issues and taking 

corrective action. 

ÅTask Inspector is a multifaceted pane offering helpful and 

intuitive information about a task, such as: 

ÅResources assigned

ÅFactors that might affect the task schedule

ÅCalendars in use. 

Use Task Inspector in conjunction with Project 2010 visual 

indicators to research potential problems. 
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Task Inspector Tool

Task Inspector displays the optimal solution, 

ÅTaking into account task characteristics (for example, 

fixed duration) 

ÅTask drivers

ÅResource calendars 

ÅFor example, click the Respect the Link option for a 

task and Project 2010 will observe predecessor tasks 

and use automatic scheduling to resolve the issue. You 

can choose which Task Inspector option to use and 

then see the results in your schedule. You can also 

choose to ignore generated advice
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Task Inspector Tool
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Using the Task Inspector

ÁUnderstand scheduling issues using underlining, 

total slack, and ñwarningò field

Filter on  

ñWarningò 

column to 

find issues

ñSquiggleò 

indicates 

there is a 

problem

ñBrokenò

or red 

indicates 

a problem

Negative Total Slack 

shows outsize 

Summary Tasks


